
 
 

College of Food, Agricultural, and Environmental Sciences 
[Department] 

Syllabus 
Principles of Agribusiness and Food 

Supply Chains  
AEDE 3105 Spring 2024 

Course Information 
• Course times and location: Mondays and Wednesdays, 12:40-2:00 p.m. Animal 

Science Bldg 210 

• Credit hours: 3 

• Mode of delivery: In-Person  

• Zoom: This is an in-person class we will not utilize Zoom this semester. 

• Watch this video it will be on Quiz #1.  Important information from Snoop Dog 
https://v.cameo.com/Yuh8FagR18 

• Important Dates 
https://registrar.osu.edu/registration/Important_dates/SP23_important%20dates.pdf 

Instructor 
• Name: Dathel Nimmons 

• Email: nimmons.6@osu.edu 

• Phone Number: 614.738.6733 

• LinkedIn Profile http://linkedin.com/in/dathel-nimmons-carpediam  
• Office location: Off Campus  

• Office hours: Before and After class M and W – or by appt.  

• Preferred means of communication: 
o My preferred method of communication for questions are; email, text, or call. I 

can also take questions during, before and after class, or by appt.  
Appointments can be in-person or Zoom.   

o My class-wide communications will be sent through the Announcements tool in 
CarmenCanvas. Please check your notification preferences (go.osu.edu/canvas-
notifications) to be sure you receive these messages. 

o All important dates for assignments, exams, quizzes, class projects will be in the 
course calendar in Carmen.  Please ensure you turn this feature on.   

https://v.cameo.com/Yuh8FagR18
https://registrar.osu.edu/registration/Important_dates/SP23_important%20dates.pdf
http://linkedin.com/in/dathel-nimmons-carpediam
https://go.osu.edu/canvas-notifications
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Teaching Assistant 
• Name: No Teaching Assistant 

• Email: N/A 

Course Prerequisites 
Econ 2001 

Course Description 
An exciting and interesting “Farm to Fork” study of the actors, intrinsic issues and support 
systems that are essential to and enable (global, domestic, regional, local) agribusiness, 
commodity and finished goods, food supply chains effectiveness. Additionally, we cover key 
supply chain processes including: demand planning, warehouse management, routing, 
scheduling, cold chain management, inventory management, lean six sigma, material resource 
planning, supplier relationship management, sourcing, procurement, purchasing, contract 
management, supply chain technology, sustainability, climate change, governmental agencies; 
roles and policies – at the regional, state and national level, food insecurity and the agencies 
that serve these vital areas. Most importantly, we will weave in all current events in the supply 
chain area to ensure recency and relevance of food supply chains to our current environment.     

Weather  
• Should in-person classes be canceled, we will meet virtually via CarmenZoom during 

our regularly scheduled time. I will share any updates via [Announcements in 
CarmenCanvas and a class email to all students. 

Learning Outcomes 
By the end of this course, students should successfully be able to: 
 

• Recall the organizational structures common to many agribusiness, commodity and 
food supply chains. 

• Describe the key actors in the agribusiness, commodity and food supply chains. 

• Describe and understand the essential processes of supply chain management and 
their interrelationships within individual companies and across agribusiness supply 
chains.  

• Understand the differences and similarities of domestic (local, regional & national) and 
international supply chains.  

• Apply the tools and techniques useful in implementing supply chain management to 
agribusiness, commodity, and food settings.  
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• Be able to map out a supply chain for any agribusiness company.  

• Understand government’s role in agribusiness at the local, regional, and federal level.  

• Understand food insecurity and the agencies, and their unique supply chains, that serve 
this area of need.   

• Understand sustainability challenges of the food supply chain and how modern 
agribusiness companies are leading the effort to create sustainable food systems.   

• Understand how climate change impacts agribusiness practices, production and supply 
chains.  

• Understand ESG and how it affects agribusiness companies.  

• Understand what it means to be a sustainable agribusiness company. 

• Understand technology and its role in efficient effective supply chains.  

• Be able to synthesize disparate information inside the agribusiness supply chains to 
improve and optimize any supply chain.  

• Understand all food supply chains and the processes that make them work.  

• Understand Lean Six Sigma and how to utilize it to achieve optimal business outcomes.   
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How This Course Works 
Mode of delivery: This course is synchronous,100% in-person, supplemented and structured 
by a course outline in Carmen. The course is divided into weekly modules that are released 
one week ahead of time, in Carmen. All course work will be submitted via Carmen 
(assignments, discussion boards, supply chain project etc…).  All quizzes, mid term and final 
will be submitted via Carmen.  
 
Credit hours and work expectations: This is a 3 credit-hour course. According to Ohio State 
bylaws on instruction (go.osu.edu/credit hours), students should expect around [3] hours per 
week of time spent on direct instruction (instructor content and Carmen activities, for example) 
in addition to 6 hours of homework (reading and assignment preparation, for example) to 
receive a grade of C average. 
 
Attendance, participation & timeliness requirements:  Research shows, regular 
participation is one of the highest predictors of success. With that in mind, I have the following 
expectations for everyone’s participation: 
 

• Be on time – class starts promptly at 12:40 pm 

• Attend every class (M&W) and participate in the classroom discussion:  You are 
expected to log in to the course in Carmen every week and read all assigned reading 
and watch the assigned videos. During most weeks you will probably log in many times. 
If you have a situation that might cause you to miss an entire week of class, discuss it 
with me as soon as possible. You are expected to attend class to ensure you are 
participating in the daily in class discussions.  These in class discussions are part of 
your grade.   

• Log into Carmen weekly; follow the modules content, format and outline; which 
includes - weekly reading, videos, discussion boards, assignments, quizzes, midterm 
and final requirements and due dates.   

• Utilize Carmen to see due dates for all graded work. 
• Utilize Carmen to view grades in real time. 
• Utilize Carmen to access and submit all graded work.  Rubrics will define the 

requirements of all assignments.   
• Inform me if you will miss class or need any assistance immediately.  
• Sign up for announcements from Carmen for this class so you can get any 

announcements in real time.  
• Discussion Boards – All DB assignments have a in-class component which will be part 

of the overall grade.    

https://go.osu.edu/credithours
https://go.osu.edu/credithours
ODEE Distance Education
To Instructor: Customize this section with information about your particular course context. 

These expectations can vary widely between courses, depending on whether the participation is synchronous (live) or asynchronous (CarmenCanvas only), so your guidance in the syllabus can be crucial.

ODEE Distance Education
To Instructor: Customize this section with your own attendance policy.

If the class has regular required Zoom meetings, indicate your attendance policy for those meetings first.

For Distanced Enhanced or Hybrid classes, include a bullet point about attendance expectations for in-person meetings.
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Course Materials, Fees and Technologies 
Required Materials and/or Technologies – You DO NOT have 
to buy these texts they are available free in pdf format, in the file section of 
Carmen.  

• Pullman & Z. Wu. Second Edition “Food Supply Chain Management, Building a 
Sustainable Future” Madeleine Pullman and Zhaohui Wu ISBN: 978-0-367-35119-9 
(hbk) **pdf document located in the File Section of the course in Carmen in the Texts 
file.  

• Global Supply Chain and Operations Management: A Decision-Oriented 
Introduction to the Creation of Value/ Ivanov, Tsipoulanidis, & Schönberger 2017. 
FREE @ OSU Library Link 

Required Equipment 
• Computer: current Mac (MacOS) or PC (Windows 10) with high-speed internet 

connection. 

• Webcam: built-in or external webcam, fully installed and tested 

• Microphone: built-in laptop or tablet mic or external microphone 

• Other: a mobile device (smartphone or tablet) to use for BuckeyePass authentication 
If you do not have access to the technology you need to succeed in this class, review options 
for technology and internet access (go.osu.edu/student-tech-access). 

Required Software 
Microsoft Office 365: All Ohio State students are now eligible for free Microsoft Office 365. 
Visit the installing Office 365 (go.osu.edu/office365help) help article for full instructions. 

CarmenCanvas Access 
You will need to use BuckeyePass (buckeyepass.osu.edu) multi-factor authentication to 
access your courses in Carmen. To ensure that you are able to connect to Carmen at all times, 
it is recommended that you do each of the following: 

• Register multiple devices in case something happens to your primary device. Visit the 
BuckeyePass - Adding a Device (go.osu.edu/add-device) help article for step-by-step 
instructions.  

• Request passcodes to keep as a backup authentication option. When you see the Duo 
login screen on your computer, click Enter a Passcode and then click the Text me new 
codes button that appears. This will text you ten passcodes, good for 365 days, that 
can each be used once. 

https://library.ohio-state.edu/record=b8181504
https://keeplearning.osu.edu/tools/tech-access
https://go.osu.edu/office365help
https://buckeyepass.osu.edu/
https://go.osu.edu/add-device
ODEE Distance Education
To Instructor: List any free or low-cost ways to access the required materials, including library e-books or print reserves, acceptable used editions, or open-access resources. 
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• Install the Duo Mobile application (go.osu.edu/install-duo) on all of your registered 
devices for the ability to generate one-time codes in the event that you lose cell, data, or 
Wi-Fi service. 

If none of these options will meet the needs of your situation, you can contact the IT Service 
Desk at 614-688-4357 (HELP) and IT support staff will work out a solution with you. 

Technology Skills Needed for This Course 
• Basic computer and web-browsing skills 

• Navigating CarmenCanvas (go.osu.edu/canvasstudent) 

• CarmenZoom virtual meetings (go.osu.edu/zoom-meetings) 

• Recording a slide presentation with audio narration and recording, editing and uploading 
video (go.osu.edu/video-assignment-guide) 

Technology Support 
For help with your password, university email, CarmenCanvas, or any other technology issues, 
questions or requests, contact the IT Service Desk, which offers 24-hour support, seven days 
a week. 
 

• Self Service and Chat: go.osu.edu/it 

• Phone: 614-688-4357 (HELP)  

• Email: servicedesk@osu.edu 

https://go.osu.edu/install-duo
tel:+16146884357
https://go.osu.edu/canvasstudent
https://go.osu.edu/zoom-meetings
http://go.osu.edu/video-assignment-guide
http://go.osu.edu/video-assignment-guide
http://go.osu.edu/it
tel:+16146884357
mailto:servicedesk@osu.edu
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Grading and Faculty Response 
How Your Grade is Calculated  

 
See Carmen for due dates. 

Descriptions of Major Course Assignments 

In-Class Discussion, Homework Assignments, Supply Chain 
Project 
Description: All assignments/in-class discussion and our supply chain project, are described 
in detail in Carmen.  Each will have a RUBRIC detailing how they will be graded and how 
many points will be awarded for each category.  Refer to Carmen for the details of all 
assignments.   
 

Quizzes/MidTerm/Final:  Quizzes/Mid-Term/Final will be in Carmen. All will primarily include 
objective questions (multiple choice, matching, fill in blank, true-false, short answer, 
essay.  Questions will cover material presented in lectures, chapter slides, the textbook, 
assigned videos, white papers and content shared by guest speakers. Students will have 60 

Assignment Category % of Grade 

Quizzes – 13 quizzes, each quiz 10 questions  20% 

In Class - Discussion & Presentations - 4 15% 

Homework Assignments - 4 20% 

Mid-Term – 30 questions  15% 

Final – 50 questions 15% 

Supply Chain Team Project – Build your own Supply 
Chain 

10%10% 

Attendance and In-class Participation 90 points total, 30 
classes, each class worth 3 points.  

 5% 
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minutes to complete each exam or quiz once you access it. All exams will be factored into your 
point distribution for your final grade. The quizzes cover the week prior material, the mid-term 
covers all material up to the mid-term and the final exam is comprehensive for the semester.   

Homework Assignments:  The 4 Homework assignments will be posted with the assigned 
Carmen module for the respective week.  Each assignment will require the students to 
synthesize and apply concepts in lecture, individual research, videos or assigned reading to 
the problems posed in the assignment.   

In-Class Discussion & Discussion Board: Students will complete 4 in-class discussion 
Assignments and answer fact based questions in the DB section of Carmen.  You must be in 
class in order to receive credit for these assignments.  The discussion board assignments will 
be based on the reading of 1 or 2 articles. The students will read the article(s) and then answer 
2-3 short questions about the article. Additionally, students will be required to respond to the 
in-class discussion and dialogue.  There will be a Rubric for each assignment. I will be 
commenting and responding to your discussions to encourage and promote critical thinking 
and meaningful interaction and dialogue.   

Supply Chain Project: Throughout the course, you will be introduced to information and 
coached on how to complete this this assignment.  Utilizing your understanding of supply 
chains, you will build your own supply chain for a manufacturing company that produces ready 
to eat, microwaveable dinners. We will discuss in class all aspects of the supply chain that you 
will build.  We will work together as a team to create the optimal supply chain for this 
assignment. Each individual will turn in their own project.     

Class Participation, Discussion and Presentations of Current Articles: I will introduce a 
current topic every class that we will discuss together in class.  Additionally, I will assign a 
current article to students for each class to read and share your learnings with your peers.  
This is a 5 minute read and a 1-2 minute presentation of what you learned from the article.  We 
will do this in every class Your overview will include key facts about the article and you will 
share any insights on how this is affecting our agriculture supply chains and what can be done 
short and long term to improve the situation. You will receive daily attendance and participation 
points for this portion of the class. This is FUN and interesting.       

Academic integrity and collaboration: Your written assignments, including discussion posts, 
should be your own original work. In formal assignments, you should follow MLA style to cite 
the ideas and words of your research sources. You are encouraged to ask a trusted person to 
proofread your assignments before you turn them in but no one else should revise or rewrite 
your work. All quizzes, mid term and final exams must be done individually.   

Late Assignments 
Late Assignments, will not be accepted after the due date. If you have an issue, contact me 
prior to the due date and we will develop a mutually agreed upon plan. I do recognize that 
sudden events or emergency situations out of your control may impact your ability to do so. If 

ODEE Distance Education
To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

Copy and paste this placeholder text to add additional categories for all your major assignment types. 

Academic integrity guidelines specific to each type will help students translate their in-person expectations to this online format. View sample syllabus language (go.osu.edu/odee-syllabus-integrity).

ODEE Distance Education

To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

Add information regarding penalties for late submission and recourse for emergencies, illness and other issues that may impact the ability to submit an assignment/complete an exam in the time published
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something does occur contact me immediately to resolve the issues.  In the event of an 
emergency, It is my policy to only accept late work within 7 days of the due date. All late work 
will result in a 15% deduction from the grade. At my discretion, exceptions may be made for 
emergencies or other well-documented issues. These exceptions are easiest to make when 
you notify me before the deadline. Please note, all late work will be graded only after I have 
completed the weekly grading of the on-time submissions and as time permits given other 
constraints on my time. 

Please refer to Carmen for due dates. Due dates are set to help you stay on pace and to allow 
timely feedback that will help you complete subsequent assignments.    
Due to the collaborative nature of class discussions if you are absent from class, you cannot 
receive credit for attendance and class participation for that day.  
Due to the collaborative nature of discussion boards, you cannot receive credit for a 
discussion board assignment that is not submitted prior to the due date. 
    

Instructor Feedback and Response Time 
I am providing the following list to give you an idea of my intended availability throughout the 
course. Remember that you can call 614-688-4357 (HELP) at any time if you have a technical 
problem. 
 

• Preferred contact method: If you have a question, please contact me first through my 
Ohio State email address or my cell phone 614.738.6733. I will reply to most 
communication immediately or at the maximum within 24 hours on days when class is 
in session at the university. 

• Class announcements: I will send all important class-wide messages through the 
Announcements tool in CarmenCanvas. Please check your notification preferences 
(go.osu.edu/canvas-notifications) to ensure you receive these messages. 

• Discussion board: I will check and reply to messages in the discussion boards in real-
time at the minimum, once mid-week and once at the end of the week. 

• Grading and feedback: For assignments submitted before the due date, I will provide 
feedback and grades within seven days. Assignments submitted after the due date 
may have reduced feedback and grades may take longer to be posted. 

 
 

tel:+16146884357
https://go.osu.edu/canvas-notifications
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Grading Scale 
93–100: A  
90–92.9: A-  
87–89.9: B+ 
83–86.9: B 
80–82.9: B-  
77–79.9: C+  
73–76.9: C 
70–72.9: C-  
67–69.9: D+  
60–66.9: D 
Below 60: E 
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Other Course Policies 
Discussion and Communication Guidelines 
[Example: The following are my expectations for how we should communicate as a class. 
Above all, please remember to be respectful and thoughtful. 
 

• Writing style: While there is no need to participate in class discussions as if you were 
writing a research paper, you should remember to write using good grammar, spelling, 
and punctuation. A more conversational tone is fine for non-academic topics. 

• Tone and civility: Let's maintain a supportive learning community where everyone feels 
safe and where people can disagree amicably. Remember that sarcasm doesn't always 
come across online. I will provide specific guidance for discussions on controversial or 
personal topics. 

• Citing your sources: When we have academic discussions, please cite your sources 
to back up what you say. For the textbook or other course materials, list at least the title 
and page numbers. For online sources, include a link. 

• Backing up your work: Consider composing your academic posts in a word processor, 
where you can save your work, and then copying into the Carmen discussion. 

• Synchronous sessions: During any Zoom sessions I ask you to use your real name 
and a clear photo of your face in your Carmen profile. During Guest Speakers Zoom 
sessions I ask that everyone leave their camera on so the guest speaker has a visual 
audience to speak to.  When in breakout rooms or other small-group discussions, 
having cameras and mics on as often as possible will help you get the most out of 
activities. You are always welcome to use the free, Ohio State themed virtual 
backgrounds (www.osu.edu/downloads/zoom-backgrounds.html). Remember that Zoom 
and the Zoom chat are our classroom space where respectful interactions are expected. 

Academic Integrity Policy 
See Descriptions of Major Course Assignments for specific guidelines about collaboration and 
academic integrity in the context of this online class. 

Ohio State’s Academic Integrity Policy 
Academic integrity is essential to maintaining an environment that fosters excellence in 
teaching, research, and other educational and scholarly activities. Thus, The Ohio State 
University and the Committee on Academic Misconduct (COAM) expect that all students have 
read and understand the university’s Code of Student Conduct (studentconduct.osu.edu), and 
that all students will complete all academic and scholarly assignments with fairness and 
honesty. Students must recognize that failure to follow the rules and guidelines established in 
the university’s Code of Student Conduct and this syllabus may constitute “Academic 
Misconduct.” 

https://www.osu.edu/downloads/zoom-backgrounds.html
https://www.osu.edu/downloads/zoom-backgrounds.html
https://studentconduct.osu.edu/
ODEE Distance Education
To Instructor: Consider whether you need to add context specific sections for health and wellness related to current events, your discipline, student population, or subject material. For example: COVID-19 disruption guidance.


ODEE Distance Education
To Instructor: The text in this section is provided as a suggestion. Fill in with your own policies. 

These expectations are appropriate for classes where discussion occurs in CarmenCanvas. �
Suggested language for classes that are largely or entirely Zoom based can be found under discussion expectations (go.osu.edu/odee-syllabus-discussion) in the ODEE syllabus template article.
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The Ohio State University’s Code of Student Conduct (Section 3335-23-04) defines academic 
misconduct as: “Any activity that tends to compromise the academic integrity of the university 
or subvert the educational process.” Examples of academic misconduct include (but are not 
limited to) plagiarism, collusion (unauthorized collaboration), copying the work of another 
student, and possession of unauthorized materials during an examination. Ignorance of the 
university’s Code of Student Conduct is never considered an excuse for academic misconduct, 
so I recommend that you review the Code of Student Conduct and, specifically, the sections 
dealing with academic misconduct. 
 
If I suspect that a student has committed academic misconduct in this course, I am 
obligated by university rules to report my suspicions to the Committee on Academic 
Misconduct. If COAM determines that you have violated the university’s Code of Student 
Conduct (i.e., committed academic misconduct), the sanctions for the misconduct could 
include a failing grade in this course and suspension or dismissal from the university. 
If you have any questions about the above policy or what constitutes academic misconduct in 
this course, please contact me. 
 
Other sources of information on academic misconduct (integrity) to which you can refer 
include: 
 

• Committee on Academic Misconduct (go.osu.edu/coam) 

• Ten Suggestions for Preserving Academic Integrity (go.osu.edu/ten-suggestions) 

• Eight Cardinal Rules of Academic Integrity (go.osu.edu/cardinal-rules) 

Copyright for Instructional Materials 
The materials used in connection with this course may be subject to copyright protection and 
are only for the use of students officially enrolled in the course for the educational purposes 
associated with the course. Copyright law must be considered before copying, retaining, or 
disseminating materials outside of the course. 

Creating an Environment Free from Harassment, 
Discrimination, and Sexual Misconduct 
The Ohio State University is committed to building and maintaining a community to reflect 
diversity and to improve opportunities for all. All Buckeyes have the right to be free from 
harassment, discrimination, and sexual misconduct. Ohio State does not discriminate on the 
basis of age, ancestry, color, disability, ethnicity, gender, gender identity or expression, genetic 
information, HIV/AIDS status, military status, national origin, pregnancy (childbirth, false 
pregnancy, termination of pregnancy, or recovery therefrom), race, religion, sex, sexual 
orientation, or protected veteran status, or any other bases under the law, in its activities, 
academic programs, admission, and employment. Members of the university community also 

https://go.osu.edu/coam
https://go.osu.edu/ten-suggestions
https://go.osu.edu/cardinal-rules
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have the right to be free from all forms of sexual misconduct: sexual harassment, sexual 
assault, relationship violence, stalking, and sexual exploitation. 
 
To report harassment, discrimination, sexual misconduct, or retaliation and/or seek confidential 
and non-confidential resources and supportive measures, contact the Office of Institutional 
Equity: 
 

1. Online reporting form at equity.osu.edu, 
2. Call 614-247-5838 or TTY 614-688-8605, 
3. Or Email equity@osu.edu 

 
The university is committed to stopping sexual misconduct, preventing its recurrence, 
eliminating any hostile environment, and remedying its discriminatory effects. All university 
employees have reporting responsibilities to the Office of Institutional Equity to ensure the 
university can take appropriate action: 
 

• All university employees, except those exempted by legal privilege of confidentiality or 
expressly identified as a confidential reporter, have an obligation to report incidents of 
sexual assault immediately. 

• The following employees have an obligation to report all other forms of sexual 
misconduct as soon as practicable but at most within five workdays of becoming aware 
of such information: 1. Any human resource professional (HRP); 2. Anyone who 
supervises faculty, staff, students, or volunteers; 3. Chair/director; and 4. Faculty 
member." 

 
This course adheres to The Principles of Community adopted by the College of Food, 
Agricultural, and Environmental Sciences. These principles are located on the Carmen site for 
this course; and can also be found at https://go.osu.edu/principlesofcommunity. For additional 
information on Diversity, Equity, and Inclusion in CFAES, contact the CFAES Office for 
Diversity, Equity, and Inclusion (https://equityandinclusion.cfaes.ohio-state.edu/). If you have 
been a victim of or a witness to a bias incident, you can report it online and anonymously (if 
you choose) at https://studentlife.osu.edu/bias/report-a-bias-incident.aspx.    

Religious Accommodations  
Our inclusive environment allows for religious expression. Students requesting 
accommodations based on faith, religious or a spiritual belief system in regard to 
examinations, other academic requirements or absences, are required to provide the instructor 
with written notice of specific dates for which the student requests alternative accommodations 
at the earliest possible date. For more information about religious accommodations at Ohio 
State, visit odi.osu.edu/religious-accommodations. 
The University Interfaith Council has a helpful, but non-exhaustive, religious holiday 
calendar to promote awareness and understanding of observances. 

http://equity.osu.edu/
mailto:equity@osu.edu
https://click.t.osu.edu/?qs=5752de7470b567c785fa816b36fe2870293d7599faf1aec396cd9c272a3673088a6b53e5da9972942150e84e1edf53c55c870a2d8c2e8754
https://click.t.osu.edu/?qs=5752de7470b567c7ba63a92b262094a82c6e2a14f0d4d3f98f9fb8ef743db659bf228af79b49aea20376fba1b73ff1aaa011e7d15f34a3bf
https://click.t.osu.edu/?qs=5752de7470b567c7ba63a92b262094a82c6e2a14f0d4d3f98f9fb8ef743db659bf228af79b49aea20376fba1b73ff1aaa011e7d15f34a3bf
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Your Mental Health 
 
As a student you may experience a range of issues that can cause barriers to learning, such 
as strained relationships, increased anxiety, alcohol/drug problems, feeling down, difficulty 
concentrating and/or lack of motivation. These mental health concerns or stressful events may 
lead to diminished academic performance or reduce a student's ability to participate in daily 
activities. The Ohio State University offers services to assist you with addressing these and 
other concerns you may be experiencing. If you or someone you know are suffering from any 
of the aforementioned conditions, you can learn more about the broad range of confidential 
mental health services available on campus via the Office of Student Life Counseling and 
Consultation Services (CCS) by visiting ccs.osu.edu or calling (614) 292- 5766. CCS is located 
on the 4th Floor of the Younkin Success Center and 10th Floor of Lincoln Tower. You can 
reach an on-call counselor when CCS is closed at (614) 292-5766 and 24 hour emergency 
help is also available through the 24/7 National Suicide Prevention Hotline at 1-(800)-273-
TALK or at suicidepreventionlifeline.org 

 
David Wirt, wirt.9@osu.edu, is the CFAES embedded mental health counselor. He is available 
for new consultations and to establish routine care. To schedule with David, please call 614-
292-5766. Students should mention their affiliation with CFAES when setting up a phone 
screening.Accessibility Accommodations for Students with Disabilities 

Requesting Accommodations 
The university strives to make all learning experiences as accessible as possible. If you 
anticipate or experience academic barriers based on your disability including mental health, 
chronic or temporary medical conditions, please let me know immediately so that we can 
privately discuss options. To establish reasonable accommodations, I may request that you 
register with Student Life Disability Services (SLDS). After registration, make arrangements 
with me as soon as possible to discuss your accommodations so that they may be 
implemented in a timely fashion. In light of the current pandemic, students seeking to request 
COVID-related accommodations may do so through the university's request process, managed 
by Student Life Disability Services. 

Disability Services Contact Information 
• Phone: 614-292-3307 

• Website: slds.osu.edu 

• Email: slds@osu.edu 

• In person: Baker Hall 098, 113 W. 12th Avenue 

https://slds.osu.edu/
https://slds.osu.edu/covid-19-info/covid-related-accommodation-requests/
tel:+6142923307
https://slds.osu.edu/
mailto:slds@osu.edu
http://www.osu.edu/map/building.php?building=095
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Safe & Healthy Buckeyes  
Health and safety requirements: All students, faculty and staff are required to comply with and 
stay up to date on all university safety and health guidance (https://safeandhealthy.osu.edu). 
Non-compliance will result in a warning first, and disciplinary actions will be taken for repeated 
offenses. 

Accessibility of Course Technology 
 
This online course requires use of CarmenCanvas (Ohio State's learning management system) 
and other online communication and multimedia tools. If you need additional services to use 
these technologies, please request accommodations as early as possible.  

• CarmenCanvas accessibility (go.osu.edu/canvas-accessibility) 

• Streaming audio and video 

• CarmenZoom accessibility (go.osu.edu/zoom-accessibility) 
 

Land Acknowledgement Statement  
(from the Multicultural Center; https://mcc.osu.edu/about-us/land-acknowledgement) 

We would like to acknowledge the land that The Ohio State University occupies is the 
ancestral and contemporary territory of the Shawnee, Potawatomi, Delaware, Miami, Peoria, 
Seneca, Wyandotte, Ojibwe and Cherokee peoples. Specifically, the university resides on land 
ceded in the 1795 Treaty of Greeneville and the forced removal of tribes through the Indian 
Removal Act of 1830. As a land grant institution, we want to honor the resiliency of these tribal 
nations and recognize the historical contexts that have and continue to affect the Indigenous 
peoples of this land. 

Course Schedule Autumn 2022 – Please refer to Carmen 
Calendar for each specific date.  Quizzes are weekly and due every 
Wednesday by 11:59 pm  

https://go.osu.edu/canvas-accessibility
https://go.osu.edu/zoom-accessibility
ODEE Distance Education
To Instructor: List any other software tools that students will be required to use to participate in the class, with links to their accessibility information, where available.
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Week Days Topics, Readings, Assignments, Due Dates 

1 M, W 

Module 1  
Syllabus Review, Course overview, Intro to Agribusiness and Food 
Supply Chains – What makes a Global Supply Chain unique? 
Introduce Discussion Board #1 – Why Global Supply Chains May Never 
be the Same. Wall Street Journal Documentary  
Quiz #1 Wednesday covers the Syllabus 

2 W 

Module 2 
Key Supply Chain Actors - Input Suppliers, Animal Protein Supply 
Chains 
Introduce Homework Assignment #1 “Value Chain” 
Due Discussion Board #1 – “Why Global Supply Chains May Never be 
the Same” – Wall Street Journal Documentary 
Quiz #2 Wednesday covers Module 1  

3 M, W 

Module 3 
Key Supply Chain Actors: Farm Output and Market Intermediaries, 
Commodity Crop Supply Chains, Fruits & Vegetables Supply Chains 
Due Homework Assignment #1 “Value Chain”  
Quiz #3 Wednesday covers Module 2  

4 M, W 

Module 4 
Key Supply Chain Actors: Food Processors and Distributors, Food 
Manufacturing and Logistics. Seafood Supply Chains  
Introduce Discussion Board #2 –Chocolate & Coffee Supply Chains, 
Fair Trade, Sustainability, Global Supply Chains 
 Quiz #4 Wednesday covers Module 3 

5 M, W 

Module 5  
Key Supply Chain Actors: Food Wholesalers, Retailers and 
Foodservice companies, Lean Six Sigma. Beverage Supply Chains 
Due Discussion Board #2 Due – Chocolate & Coffee Supply Chains 
Introduce Homework Assignment #2 “Cold Chain Management, 
Perishability and Technology” 
Quiz #5 Wednesday covers Module 4  
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6 M, W  

Module 6 
Intrinsic Issues: Perishability & Cold Chain Management, Inventory 
Management, Warehouse Management, Demand Forecasting and 
Planning, Sales & Operational Planning   
Due Homework Assignment #2  
Quiz #6 Wednesday covers Module 5  

7 M, W 

Module 7 
Sustainability, ESG (Environmental, Social, Governance), Climate 
Change & implications to Agribusiness. Middle & Last Mile Delivery 
Introduce Discussion Board #3 Sustainability & ESG - Aviagen, a 
unique supply chain of a critical supplier to the poultry industry 
Quiz #7 Wednesday covers Module 6 

8 M, W 

Module 8  
Introduction to Class Project & Review for Mid Term  
Mid Term Wednesday covers Modules 1-7 in class  

9 M, W  

Module 9view  
Intrinsic Issues: Risk and Quality, Fair Trade, Global Supply Chain 
Due Discussion Board #3 Sustainability ESG  
Quiz #8 Wednesday covers Modules 7 & 8  

10  Spring Break  

11 M, W 

Module 10  
Key processes: present in all Supply Chains: Demand Planning and 
Forecasting, Metrics, KPI’s, Benchmarking, Dashboards, Perfect Order   
Quiz #9 Wednesday covers Module 9  

12 M, W  

Module 11 
Intrinsic Issues: Food Safety, Identity preserved food supply chains, 
Tracing, Animal Welfare. 
Quiz #10 Wednesday covers Module 10     

13 M, W  

Module 12 
Support Systems: Technology  
Introduce Homework Assignment #3 “Technology in Agribusiness and 
Food Supply Chains”  
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Due Homework Assignment #3  
Quiz # 11 Wednesday covers Module 11 

14 M, W  

Module 13  
Support Systems – Role of Government, regulations and verification 
methods, organic, Food Aide and Hunger Relief, Agencies that serve 
the food insecure, Disaster Relief.  
Introduce Homework Assignment #4 The role of government, 
oversight, policies, programs “USDA”  
Quiz #12 Wednesday covers Module 12  

15 M, W 

Module 14 
Intrinsic Issues: Supplier Management, Sourcing, Contracts, 
Procurement, Purchasing.  
Due Homework Assignment #4   
Introduce Discussion Board #4 “Elevator Pitch”  
Final Quiz #13 Wednesday covers Module 13 & 14 

16 M, W 

Module 15 
Due Supply Chain Project  
Final Review   
In Class Discussion Board #4 “Elevator Pitch” 
Final and In Class Presentation of Class Project  
Last day of classes Wednesday 12/6/2023  
Reading Day Thursday 12/7/2023 

17  Finals Friday December 8th, 2023 – Thursday December 14th, 2023 

ODEE Distance Education
To Instructor regarding accessibility: Before sharing this document with students, the instructor will need to do the following:

 Select File > Properties > Summary > Title to replace “[Title of Course]” and “[Term]” with the actual title and term of the course. 
 Double click to update the footer text box with the correct College and Department for your course
 Right click the footer text box and select “Edit Alt Text” to update the alt text with the same College and Department information. 
Throughout the template remove all brackets and instructional text and replace with course-specific information. To do this quickly you can use Edit > Find to search for “[”
 Delete any non-applicable items.
 Select Review > Check Accessibility and resolve any accessibility errors.
 Rename the file “[CourseAbbrev]-[Term]-syllabus.doc” (or follow whatever convention your unit uses).

Please also be aware that the styling and heading structure of this document are accessibility features and editing the styling and structure could render the document inaccessible.
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